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What RBC Pages Should Be Submitted?

For year-end 2017 fraternal RBC, submit hard copies of
pages FR0O01 through FRO049 to any state that requests a
hard copy. A hardcopy is not required to be submitted to
the NAIC.

If any actuarial certifications are required per the RBC
instructions, those should be included as part of the hard-
copy filing. Other pages, such as the mortgage and real
estate worksheets, do not need to be submitted, but they
still need to be retained by the company as documenta-
tion.

Risk-Based Capital Level of Action

As a result of the adoption of agenda item 201
RBC Ratio by the Capital Adequacy (E) Tas
the Spring National Meeting, a line was added
Risk-Based Capital Level of Action to show the AT
ized Control Level RBC ratio to be consistgnt with
other RBC formulas and to simplify data p

In This Isc c.

What RBC Pages 2 Submit

Risk-Based Capital Level of Action

XXXIAXXX Reins. Primary Sec. Shortfall .
Operational Risk

Money Market Mutual Funds

Unaffiliated Common Stock Money Market Mutual

Supp. Ben. w/S
Stop Loss
Contact Information

XXXIAXXX Reinsurance Primary Security
Shortfall by Cession

As a result of the adoption of a a it
Primary Security Shortfall Change by the

g I
Capital Adequacy (E) Jask | @ its June 28 confer-
ence call, changes wer o " the instructions to
clarify only list cessi %to Actuarial Guideline
XLVII—Actuarial Memorandum Require-
ments for the Rei e Of Policies Required to be
d 7 of the NAIC Valuation of
odel Regulation (AG 48). For

some policies subject to AG 48 and
ct to the Term and Universal Life

2017-02-L

some polgie

Insurg@Ce rve Financing Model Regulation (#787),
(&orti of the cession regulated by AG 48 is to
b u

As a result of a technical issue that was presented during
the June 28 Capital Adequacy (E) Task Force conference
call, implementation of a risk factor for Operational Risk
has been deferred for at least a year. The Task Force
adopted agenda item 2016-13-O at the Spring National
Meeting and modified it on its June 28 conference call.
At the Spring National Meeting, the Task Force, in
essence, voted to “go live” for 2017 reporting by adopt-
ing the structural change to remove the proxy-based
approach, move the “add-on” approach for basic opera-
tional risk to page FRO31 and retain the growth risk por-
tion of the information only page. On its June 28 confer-
ence call, the Task Force adopted the operational risk
instructions but voted to reduce the recommended RBC
charge from 1.5% to 0% for 2017 to allow the Operation-
al Risk (E) Subgroup to address the technical concerns
raised.
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Money Market Mutual Funds

As a result of the reclassification of money market mu-
tual funds (MMMFs) to cash equivalents by the Statu-
tory Accounting Principles (E) Working Group, the

Stop Loss

As a result of the adoption of agenda item 2016-17-CA
by the Capital Adequacy (E) Task Force at the Spring
National Meeting, a tiered factor ap h will be ap-

Capital Adequacy (E) Task Force adopted agenda ittm  plied to Stop Loss premiums. A f added to

2016-15-CA at the Spring National MMMFs will be  apply a factor of 0.350 to the fi million in stop

isolated on their own line on the Miscellaneous Assets  loss premium and a factor of @ emium in ex-

schedule and subtracted from the cash equivalents. The  cess of $25 million. 23

Annual Statement Source will be Schedule E, Part 2,

Column 7, Line 8599999, \

Unaffiliated Common Stock MMMFs Supplemental @ within Stand-Alone
Medici verage

As a result of the adoption of agenda item 2017-06-CA,
by the Capital Adequacy (E) Task Force onthe June 28 A t of
conference call, the factor was modified to 0% on Line  py
(22) on FRO05 Unaffiliated Preferred and Common
Stock. The purpose of the modification is to avoid the
double counting of MMMFs in both cash equivaleng\gls

adoption of agenda item 2016-16-CA
Capial Adequacy (E) Task Force at the Spring
ion eting, the factor for Supplemental Benefits
ithStand-Alone Medicare Part D Coverage was in-
0 0.500 and will be applied to claims incurred.

and common stock. The instructions were also r
to reflect the change.

9
o

on of Insurance Commissioners

Direct correspondence to: Dave Fleming, RBC Newslet-
ters, NAIC, 1100 Walnut Street, Suite 1500, Kansas City,
MO 64106-2197. Phone: (816) 783-8121. Email: dflem-
ing@naic.org.

Address corrections requested. Please mail the old
address label with the correction to: NAIC Publications
Department, 1100 Walnut Street, Suite 1500, Kansas
City, MO 64106-2197. Phone: (816) 783-8300. Email:
prodserv@naic.org.

Fraternal Risk-Based Capital Newsletter Volume 10. Pub-
lished annually or whenever needed by the NAIC for
insurance regulators, professionals and consumers.
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Fraternal
Risk-Based Capital Forecasting

Spreadsheet Instructions

The Fraternal RBC Forecasting CD-ROM contains a spreadsheet that calculates RBC,fisin same
formula presented in the 2017 NAIC Fraternal Risk-Based Capital Report Including§Qverview &
Instructions for Companies. A hard copy of this booklet is mailed with the forec OM or is
available for download from the NAIC Publications Department. L 4

The forecasting spreadsheets can be used to check RBC results throughout th Nt an early look at
RBC results before the RBC vendor filing software may be available, or to uaiydvhat-if” scenarios.

WARNIN

The RBC Forecasting Spreadsheet CANN seéd to meet the year-end
RBC electronic filing requirement. R software from an annual
statement software vendor should be eate the electronic filing. If
the forecasting worksheet is sent igste n electronic filing, it will not be

accepted, and the RBC will not hav% ed.

User Requirements

About the File

The spreadsheet Forecast Frat 2017 08
18.xIsm was created in Microsoft Excel. The
spreadsheet can be used with Microsoft Excel
version 14.0 or higher. The spreadsheet
includes menus for use in navigation between
pages and for printing.

Excel 2010 (or compati
* Five megabytes of hard @i
* A good understandi
software.

The RBC spreadsheet above follows the 2017
Fraternal Risk-Based Capital Report Including
Overview and Instructions for Companies
formula pages. A copy of the instructions and
_ blank are included with the CD-ROM to assist
08_18.xIsm file in the directory where you in the completion of the forecasting file.
would like the file to be saved.
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Usage
1. Open the Forecast_Frat 2017 _08_18.xIsm file by double clicking on the file.

2. Enter data as described in the following sections and examine the results.
3. Save any changes to the spreadsheets using the “Save” command from the “File” menu.

Please Note

In certain versions of Excel, the user may receive the following message when the ing file is
opened:

.\') Security Warning  Some active content has been disabled. Click for more details,

If this is the case, the user would need to click on the “Enable Content” hutton

To change the Excel security level, go to the Developer tab, in , click Macro Security. In
the Macro Settings, select the security option. ¢
h

Macro Settings

&ifcatinn

it

ﬁ a ept digitally signed macros
le cros (not recommended; potentially dangerous code can run)

j 3 P Record Macro Disable all macras
1 =22 B3 uss Ralative References @ Disable g¥inac

Visual Macro
Basic

ification

e Blue-shaded cells are da that tie directly to the 2017 fraternal annual statement (i.e.,
vendor link items). be found in the company's annual statement filing.

e Red-shaded cells ar ts that are not available directly from the annual statement (e.g.,
manual data entry ite These items come from other company records as noted in the
spreadsheet.

e Grey-shaded ¢ re data elements calculated automatically by the spreadsheet. These cells are
protected.

Green-sha

@ 5 are data elements that must be entered using a separate input worksheet.
hegPell will automatically take the user to the input worksheet when using the
at 2017 08 18.xIsm file. Data input into the separate worksheet will feed
to the main page.
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What-If Scenarios

One of the unique features of the forecasting spreadsheet is its ability to perform what-if calculations.
Because the formula is implemented through the Excel Spreadsheet, the user is able to run various
scenario by adjusting the book/adjusted carrying value, amount or statement value to analyze the effect
such changes would have on the company’s overall RBC ratio based on the RBC factors and covariance.

from the “File” menu. The spreadsheet program will prompt to save any files tfit ha hanged.

Saving and Exiting Q
To exit the program, simply click the n in the upper right corner of the file or chg “EXit” option
'abee

» Answer “yes” at the prompt to save any changes, such as data input or form anges.

» Answer “no” if the saving is not desired. Warning: This will ignore any arall r changes.
Printing

A print menu was added to aid in printing for Excel users. (,ﬁ DOX next to the page name for
0
esel

the individual pages desired to be printed. Then select the b yrint Selected Pages.” Select the
“Reset” button any time it is desired to have all bytton d. Individual boxes can also be
deselected by clicking on them.

RBC Forecasting Tips

1. Make sure the CD-ROM is retained so 7
not replace the CD-ROM unless it wa

c of the Excel file is available. The NAIC will
adu shipping or is otherwise defective.

gf/estments section before beginning. In some instances
various affiliates themselves.

2. Gather information required for the affiliclg
information will need to be gathereg from the

3. Keep a copy of the NAIC ann ent blank and annual statement instructions nearby and refer to
them as needed.

4. Keep the copy of the R w and Instructions at the computer to be used as a reference while
filling out the spreadsheet. preadsheet follows the RBC Overview and Instructions formula pages
exactly.

5. Make a list of ns hile filling out the spreadsheet. Then call the NAIC staff once, saving both
parties .

icemail messages, make the question as specific and detailed as possible. We will
then le to call back with the answer, saving time spent on the phone. Please leave a phone number
or email c§glress, and we will get back to you with an answer as soon as possible.

© 1998-2017 National Association of Insurance Commissioners
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Questions and Support

If problems are encountered, please refer to the RBC Overview and Instructions booklet and/or the
Forecasting Spreadsheet Instructions first. However, if there is still a question, contact the NAIC.

For questions pertaining to annual statement references, insurance accounting questions or formula
questions, contact Dave Fleming (NAIC).

For computer-usage related questions (loading the product, etc.), contact the NAIC Help Q
Important Contact Information & O

e Formula questions: Dave Fleming (816) 783-8121; dfleming@naic.org. \\

» Computer questions: NAIC Help Desk (816) 783-8500; Help@naic.o
» Annual statement questions: NAIC Financial Reporting Quessi LiE(816) 783-8400

<
Questions on publications: NAIC Publications (816) 783-83 r @naic.org.

N
&

9

o
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NAIC

National Association of Insurance Commissioners

The National Association of Insurance Commissioners
(NAIC) is the U.S. standard-setting and regulatory support
organization created and governed by the chief insurance
regulators from the 50 states, the District of Columbia and five
U.S. territories. Through the NAIC, state insurance regulators
establish standards and best practices, conduct peer review,
and coordinate their regulatory oversight. NAIC staff supports
these efforts and represents the collective views of state
regulators domestically and internationally. NAIC members,
together with the central resources of the NAIC, form the
national system of state-based insurance regulation in the U.S.

For more information, visit www.naic.org.
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